
P O G L A V L J E  J E D A N

Početak

Pre nekoliko godina firma Adobe Systems predstavila je PDF (Porta-
ble Document Format) kao nov format dokumenata. Bio je to revo-
lucionaran potez – dokument koji čitalac vidi na ekranu verna je 
kopija onoga što se pojavljuje u štampi. Više nije neophodno da 
usklađujete dizajn i izgled stranice s mogućnostima računara koji 
će otvoriti i prikazati dokument. 

Adobe neprekidno razvija PDF format i programski paket Acrobat. 
Od skromnog početka 1992. godine do danas, Acrobat je doživeo neko-
liko verzija. Poslednji izdanak ove porodice programa nosi oznaku 
Acrobat 6. Pošto čitate ovu knjigu, znači da ste ponosni vlasnik pro-
grama Acrobat 6 Standard. Acrobat 6 obuhvata i verzije Professional 
i Elements, koje nude različite mogućnosti i funkcionalnost.

Dok učite da koristite program, postajete svesni dve važne 
činjenice:

• Ništa nije „standardno“ kada je reč o programu Acrobat 
Standard.

• Prikazivanje PDF datoteka samo je deo onoga što Acrobat 
pruža.

U ovom poglavlju upoznaćete komponente programa i naučićete 
kako da postignete da korisničko okruženje radi za vas. Podrazume-
vano radno okruženje obuhvata nekoliko paleta sa alatkama i opci-
jama, ali nije neophodno da sve bude na ekranu u isto vreme.
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SAVET 

1  Mesto za sve
Kada prvi put pokrenete Acrobat 6 Standard, pojaviće se okruženje 
prikazano na slici 1.1 (naravno, bez slike ruže). Na ekranu ćete 
videti sledeće komponente:

Slika 1.1 Korisničko okruženje Acrobata 6 ima nekoliko oblasti.

• Osnovni meni. Stavke osnovnog menija poređane su pri vrhu 
prozora (slika 1.2). Sa stavkama File, Edit, View, Window i 
Help već ste se upoznali. Ostali elementi osnovnog menija, 
poput Document, Tools i Advanced, sadrže opcije koje su speci-
fične za Acrobat.

Slika 1.2 Pojedine stavke osnovnog menija nalaze se i u drugim  
programima.

Linija menija Palete alatki Okno How To

Prozor dokumenta Statusna traka Pomoć
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• Palete alatki. Acrobat 6 ima mnogo paleta alatki. Osnovni 
raspored paleta prikazan je na slici 1.3. Mnoge opcije na pale-
tama alatki na raspolaganju su i kao komande iz menija. Stre-
lica na desnoj strani usmerena nadole ukazuje na postojanje 
skrivene palete alatki. Pritisnite strelicu da biste prikazali skri-
vene opcije.

Slika 1.3 Osnovna paleta alatki i paleta poslova programa sastoje se od 
nekoliko komponenata.

• Okno Navigation. Duž leve strane prozora videćete skup ver-
tikalno poređanih kartica. Ove kartice čine okno Navigation 
(slika 1.4), a opcije u njima omogućavaju vam da na različite 
načine upravljate PDF dokumentima i kontrolišete njihov sadr-
žaj. Na slici je prikazan podrazumevan skup kartica.

 
Slika 1.4 Okno Navigation nalazi se 
na levoj strani prozora programa.

• Prozor dokumenta. Otvoreni dokumenti prikazuju se u pro-
zoru dokumenta (slika 1.5). Ispod otvorenog dokumenta, 
Acrobat prikazuje veličinu stranice. Vertikalna i horizontalna 
klizna traka dozvoljavaju premeštanje vidljivog dela doku-
menta prema potrebi.

Pogledajte pre nego što 
dodirnete
Izgled korisničkog okruženja 
možete da promenite tako što 
ćete premestiti ili zatvoriti pale-
te alatki, kartice okna Naviga-
tion itd. Pre nego što to učinite, 
upoznajte se sa njihovim sadr-
žajem. Primera radi, pritisnite 
padajuće menije da biste videli 
skrivene alatke ili opcije. Pri-
tisnite jezičak kartice u oknu 
Navigation i pogledajte koje su 
opcije dostupne. Analiziranje 
osnovne postavke Acrobata mo-
že vam pomoći dok učite kako 
se radi u ovom programu.

SAVET 1: Mesto za sve
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Slika 1.5 Koristite prozor 
dokumenta da biste  
kontrolisali svoju poziciju  
u dokumentu.

• Statusna traka. Statusna traka se nalazi ispod prozora doku-
menta (slika 1.6). Na njoj se vide redni broj tekuće strane, 
ukupan broj strana i način prikaza dokumenta. Odgovarajuća 
ikonica označava da li su prikazane pojedinačne strane ili 
neprekidan niz strana. Koristite komande za kretanje da biste 
se pomerali unazad ili unapred po dokumentu.

Slika 1.6 Statusna traka pokazuje broj tekuće strane, ukupan broj stra-
na i način prikazivanja stranica u dokumentu.

• Kako da... Okno How To (slika 1.7) nalazi se na desnoj strani 
ekrana i prikazuje nekoliko veza ka uputstvima za uobičajene 
poslove koji mogu da se obave u Acrobatu. Ovo okno je odvo-
jeno od sistema za pomoć i koristi se za brži pristup uput-
stvima. Oknu ne možete da promenite veličinu, ali možete da 
ga sakrijete.

 
Slika 1.7 Koristite okno How To za 
brzu pomoć u radu s programom.
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SAVET 

2  Prva pomoć
Okno How To sadrži listu uobičajenih poslova koje ćete najčešće oba-
vljati pomoću Acrobata (slika 1.8). Pridržavajte se sledećih saveta 
da biste pomoću okna How To došli do uputstava za rad s progra-
mom:

 

Slika 1.8 Izaberite neku od 
glavnih tema da bi se prikazao 
spisak tema u oknu How To.

• Spisak glavnih tema pojavljuje se u oknu How To (slika 1.9). 
Koristite klizne trake da biste pristupili kompletnom spisku. 
Pritiskom na hipervezu ka nazivu određenog posla, uspećete 
da pristupite odgovarajućem uputstvu.

 

Slika 1.9 Svaki izabrani posao 
sadrži i spisak tema koje se na 
njega odnose.

• Uputstvo za izvršavanje posla ili zadatka pojavljuje se u oknu 
How To (slika 1.10). Pomerajte prikaz u oknu liste da biste 
pročitali čitavo uputstvo.

 

Slika 1.10 Pročitajte uputstvo 
ako ne znate kako da dovršite 
započeti posao.

SAVET 2: Prva pomoć

Kako da... ili ne
Neki korisnici se osećaju sa-
svim prijatno kada je ekran 
preplavljen menijima i okvirima 
za dijalog; drugi prednost daju 
što većem radnom prostoru. U 
podrazumevanom stanju, Acro-
bat nakon učitavanja prikazuje 
okno How To. Ovo okno možete 
sakriti i koristiti druge opcije da 
biste, kad vam to zatreba, pri-
stupili uputstvima za rad 
s programom:

• Pritisnite dugme Hide i zatvori-
te okno ako za posao koristite 
opcije koje dobro poznajete. 

• U podrazumevanoj postavci 
paleta sa alatkama, pritisnite 
dugme How To kako biste po-
novo otvorili okno. Okno će 
se pojaviti na istom mestu 
na ekranu.

• Neka okno How To bude otvo-
reno sve dok ne upoznate op-
cije Acrobata i naviknete se 
na rad u ovom programu. Ako 
smatrate da posao možete 
obaviti i bez uputstava, poni-
štite izbor opcije Show How 
To Window at Startup u oknu 
How To. Od tog trenutka, 
okno How To neće se prikazi-
vati kada pokrenete program, 
ali ga možete otvoriti ukoliko 
vam zatreba.
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• Pri kraju uputstva za neki posao, pronaći ćete dodatne hiper-
veze (slika 1.11). Upotrebite ove veze da biste pronašli više 
podataka o sličnim poslovima, i hiperveze ka glavnom meniju 
Help.

 

Slika 1.11 I dalje ne znate kako da  
nešto uradite? Za dodatne podatke 
sledite hipervezu ili upotrebite glavni 
sistem za pomoć.

• Koristite tastere za kretanje na vrhu okna How To, da biste oda-
brali odgovarajući prikaz (slika 1.12). Pritiskanjem aktivne 
strelice (ikonice aktivnih strelica obojene su plavom bojom), 
kretaćete se između stranica koje ste pregledali; pritisnite 
taster miša da biste se vratili na glavnu stranicu okna How To.

Slika 1.12 Poziciju u dokumentu možete kontrolisati  
pomoću dugmadi za kretanje u oknu How To.

Kako da...
Ukoliko promenite raspored 
paleta alatki, verovatno ćete 
zatvoriti okno How To. Da biste 
pristupili njegovom sadržaju, 
upotrebite meni Help. Izaberite 
komandu Help > How To Win-
dow i potom izaberite jednu 
opciju sa liste. 
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SAVET 

3  Upotreba menija Help
Okno How To pruža uputstva „korak po korak“ za rad sa osnovnim 
funkcijama i opcijama programa. Ukoliko su vam potrebni detaljniji 
podaci, koristite glavni sistem za pomoć:

1. Izaberite opciju Help > Complete Acrobat 6.0 Help (slika 
1.13). Sistem za pomoć u vidu zasebnog programa otvoriće se 
u sopstvenom prozoru.

  

Slika 1.13 Celovit sistem za pomoć 
Acrobat 6 Help otvara se u zasebnom 
prozoru.

2. Koristite komande za kretanje po sistemu za pomoć koje se 
nalaze u vrhu leve strane prozora (slika 1.14). Plave strelice 
vam omogućavaju kretanje po stranama na kojima ste već bili. 
Pritisnite ikonicu štampača da biste odštampali temu koja je pri-
kazana u osnovnom oknu prozora Help. Ikonice plus (+) i minus 
(-) omogućavaju vam da povećate ili da smanjite prikaz.

 
Slika 1.14 Koristite odgovarajuće ko-
mande za kretanje po sistemu za pomoć.

3. Odaberite jedan od tri modela ponuđenih opcija za pretraži-
vanje – Contents, Search ili Index – zavisno od toga šta tražite 
i kako ste navikli da radite:

• Kada otvorite meni Help u njemu se vidi sadržaj kartice Con-
tents (slika 1.15). Svaki znak plus (+) pored imena teme 
označava postojanje podteme. Pritiskom na + otvara se 
lista ugnežđenih stavki. Ukoliko je uz ime teme minus (-), 
to znači da je ugnežđeni sadržaj već prikazan. Pritisnite 
stavku da bi se njen sadržaj prikazao u osnovnom oknu pro-
zora Help.

SAVET 3: Upotreba menija Help
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Slika 1.15 Određene teme su grupisane 
unutar većih tema na levoj strani okna.

• Pritisnite jezičak kartice Search da biste prikazali njen sadr-
žaj. Unesite reč koju tražite i pritisnite dugme Search. Teme 
koje sadrže traženu reč ili pojam prikazaće se u levom oknu 
prozora Help (slika 1.16). Pritisnite naziv teme na listi u 
levom oknu da bi se njen sadržaj prikazao u glavnom oknu; 
Acrobat će istaći svako pojavljivanje traženog pojma.

Slika 1.16 Koristite mogućnosti opcije Search da biste pronašli  
odgovarajući pojam u sistemu za pomoć.

Napomena
Ukoliko vam istaknuti pojmovi odvlače pažnju, alatkom Hand pritisnite 
bilo koje mesto na stranici i tako uklonite isticanje reči.

Pomoć oko pomoći
Obratite pažnju na to kako radi-
te u Acrobatu. Ukoliko ste siste-
matični u radu, koristite karticu 
Contents prozora Help jer ćete 
tako lakše pristupati temama, 
od opštih do specijalizovanih. 
Ukoliko dobro poznajete Acro-
bat i znate koje podatke tražite, 
koristite opciju Search. Ako 
niste sigurni koju temu tražite, 
ali načelno imate ideju, pokušaj-
te sa opcijom Index. Ponekad je 
dovoljno da vidite samo deo na-
slova da biste shvatili da upra-
vo to tražite.
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 • Izaberite jezičak kartice Index, a potom iz menija Show iza-
berite opciju All da biste prikazali spisak tema po abeced-
nom redu (slika 1.17). Izaberite početno slovo reči koju 
tražite u indeksu, ili ostavite aktivnu opciju All. Krećite se 
kroz listu u levom oknu prozora Help. I ovog puta sadržaj je 
prikazan u ugnežđenim temama. Pritisnite tasterom miša da 
biste otvorili temu. Ukoliko pritisnete ime teme, njen sadržaj 
unutar indeksa prikazaće se u glavnom oknu prozora Help. 

 
Slika 1.17 Teme možete pretraživati 
pomoću kartice Index.

Napomena
Za neke poslove sistem za pomoć će vam često biti potreban. Da ne biste 
stalno zatvarali prozor Help i ponovo ga otvarali tražeći pravi podatak, 
minimizirajte prozor. Njegov sadržaj će biti isti kao kada ste ga posled-
nji put prikazali, pa možete jednostavno da prelazite iz dokumenta u 
Acrobatu u prozor Help i obrnuto (slika 1.18). Takođe, možete promeniti 
veličinu oba prozora i istovremeno ih prikazati na ekranu, ali ukoliko ne 
morate da čitate baš svaku reč uputstva, minimizirajte prozor da biste 
bolje iskoristili radni prostor na ekranu.

 

Slika 1.18 Prikažite 
istovremeno prozore 
vašeg dokumenta 
i prozor sistema za 
pomoć.

SAVET 3: Upotreba menija Help
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SAVET 

4  Oslobodite prostor na ekranu
Jedan od najboljih načina da obezbedite dovoljno prostora na ekranu 
i da sačuvate vid, jeste da smanjite broj prikazanih alatki. Slika 1.19 
pokazuje kako ne treba da izgleda radni prostor. Skoro sve palete i 
dugmad za pokretanje poslova nalaze se na ekranu. Čak i u prikazu 
preko celog ekrana, ostaje veoma malo prostora za tekući dokument. 
Pored toga, potrošićete mnogo vremena pokušavajući da pronađete 
neku alatku kada vam zaista zatreba. Naredne preporuke će vam 
pomoći da umanjite zbrku na ekranu. 

Slika 1.19 Ukoliko otvorite sve palete alatki, ostaće vam malo prostora za rad.

• Čak i ako koristite samo osnovne palete alatki, možete se zbu-
niti. Postavite pokazivač iznad šrafirane vertikalne linije na levoj 
ivici palete alatki da bi se prikazalo ime palete (slika 1.20).

 
Slika 1.20 Prikazivanje imena palete 
alatki u ekranskom savetu.

• Ekranski saveti prikazuju nazive dugmadi. Ukoliko je dugme 
dovoljno veliko da se na njemu vide i ikonice i tekst, iz saveta 
nećete saznati ništa novo. Međutim, ako postavite pokazivač 
miša preko ikonice, pojaviće se ime dugmeta iz koga možete 
da zaključite koja je njegova funkcija (slika 1.21).

 
Slika 1.21 Ekranski savet prikazuje 
ime dugmeta.

Mogućnost ponovnog 
vraćanja
Ukoliko ste prikazali znatan broj 
paleta alatki a želite da se vra-
tite na podrazumevani skup, 
izaberite opciju View > Toolbars 
> Reset Toolbars. Okruženje će 
ponovo izgledati kao nakon 
prvog pokretanja programa.
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• Postavite pokazivač miša iznad šrafirane vertikalne linije i 
povucite da biste pomerili paletu alatki sa pozicije na kojoj je 
usidrena. Kada otpustite taster miša, paleta alatki će plutati 
na ekranu (slika 1.22).

 
Slika 1.22 Paleta alatki može se usidriti 
na vrhu prozora ili plutati na ekranu.

• Dugmad za pokretanje poslova radi neznatno drugačije. Ne 
možete prevući samo jedno dugme s palete poslova (što možete 
uraditi s pojedinačnim alatkama na paletama); ako to pokušate, 
premestićete čitavu paletu. Izaberite opciju View > Task But-
tons i odaberite dugmad ili poništite njihov izbor (slika 1.23).

 

Slika 1.23 Dugmad 
za pokretanje poslova 
iz menija View.

• Dok radite, često ćete menjati palete. Uštedite jedan korak 
koristeći priručne menije. Pritisnite desni taster miša ili uz pri-
tisnut taster Ctrl, mišem pritisnite traku za razdvajanje i prika-
zaće se iste opcije koje su vam na raspolaganju kada koristite 
menije palete alatki (slika 1.24). 

 

Slika 1.24 Koristite priručni meni za prika-
zivanje komandi koje su dostupne iz menija 
View.

SAVET 4: Oslobodite prostor na ekranu

Zaključavanje paleta 
alatki
Kada zatvorite pa ponovo otvo-
rite program, raspored paleta 
alatki i dugmadi za poslove osta-
je isti. Ukoliko vam odgovara 
drugačiji raspored, zaključajte 
palete. Kada Acrobat upoznate 
do te mere da se u njemu oseća-
te „kao riba u vodi“, odaberite 
alatke s kojima ćete raditi bez 
stalnog pretraživanja po paleta-
ma. Izaberite View > Toolbars 
> Lock Toolbars. Tom prilikom 
nestaće linije za razdvajanje 
između paleta. Plutajuće palete 
se ne zaključavaju i ne mogu se 
usidriti uz zaključane palete.
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SAVET 

5  Početak rada punom brzinom
U Acrobatu možete podesiti nekoliko parametara koji će vam omo-
gućiti brži rad, bilo da je reč o bržem pokretanju programa ili da se 
rezultati rada u dokumentu brže prikazuju:

1. Izaberite opciju Edit > Preferences > General. Otvoriće se okvir 
za dijalog Preferences sa podužim spiskom parametara u levom 
oknu. Izaberite stavku Startup da bi se u desnom oknu okvira za 
dijalog pojavili parametri za pokretanje programa (slika 1.25).

Slika 1.25 Pomoću parametara Startup promenite način na koji se  
program pokreće. 

2. Odeljak Opening Documents nalazi se u gornjem delu prozora. 
U padajućoj listi Reopen Documents to last Viewed page, pod-
razumevano je izabrana opcija eBooks Only, što znači da će se 
samo elektronske knjige ponovo otvoriti na onoj strani koja je 
poslednja prikazana u prozoru dokumenta.

Pritisnite strelicu padajuće liste i izaberite opciju All Files 
(slika 1.26). Ovaj parametar je veoma koristan kada mnogo 
vremena provodite radeći sa više dokumenata. Svaki put kada 
otvorite dokument, mesto u dokumentu i stranica koja je 
poslednji put prikazana pojaviće su u prozoru dokumenta.

 

Slika 1.26 Koristite opciju 
All Files kada radite sa više 
dokumenata.

Uvodni ekran
Donji odeljak parametara Star-
tup sadrži opciju za prikazivanje 
uvodnog ekrana. Nekim korisni-
cima se dopada ideja da isklju-
če prikazivanje uvodnog ekrana 
misleći da na taj način ubrza-
vaju program. To nije tačno. Ja 
više volim kada se uvodni ekran 
prikazuje bar dok se dovoljno 
ne nagledam crteža na njemu.
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Napomena
Opcija za prikaz radi na opisani način samo tokom jedne seanse u Acro-
batu 6; ukoliko zatvorite i ponovo otvorite program, a potom i dokument, 
prikaz zavisi od parametara dokumenta te će se uglavnom videti vrh prve 
strane.

3. Izaberite opciju Use Page Cache (koja podrazumevano nije 
izabrana). Ukoliko keširate strane, dok gledate jednu stranu 
dokumenta, sledeća se učitava i smešta u rezervisani prostor 
(engl. buffer area), sve dok ne odlučite da je pogledate. Tako 
se strane brže učitavaju što je posebno uočljivo dok radite sa 
interaktivnim dokumentima ili ako u njima ima mnogo slika.

4. Preostale dve opcije koje pripadaju oblasti Opening Docu-
ments, mogu da ostanu izabrane. Layer State se koristi za 
dokumente sa slojevima; autor dokumenta određuje koji će 
se slojevi prikazati kada se dokument otvori u Acrobatu. Treća 
opcija, Display the Document Status Dialog for, omogućuje da 
se prikažu dodatni podaci o objektima, kao što su slojevi i digi-
talni potpisi.

5. Izaberite stavku Page Display u levom oknu okvira za dijalog 
Preferences. Ovde možete podesiti pojedine parametre stra-
nica kako biste radili brže.

6. Acrobat podrazumevano prikazuje velike slike. Poništite izbor 
opcije Display large images (slika 1.27) ukoliko vaš računar 
sporo iscrtava sadržaj ekrana. Slika će se prikazati i na sporom 
računaru, ali treba mnogo vremena da se ona iscrta na ekranu. 
Svaki put kada upotrebite klizne trake ili na drugi način pome-
rite dokument u prozoru dokumenta, morate sačekati da se 
slika ponovo iscrta.

 

Slika 1.27 Ukoliko vaš računar 
ne može brzo da iscrtava slike, 
isključite prikazivanje velikih 
slika.

SAVET 5: Početak rada punom brzinom
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7. Izaberite opciju Use greek text below xx Pixels, da biste tekst 
manji od zadate veličine (podrazumevana veličina je 6 pik-
sela) prikazali kao sive linije (slika 1.28). Izborom ove opcije 
brzina iscrtavanja znatno se povećava.

 

Slika 1.28 Zamena veoma sitnog 
teksta sivim linijama ubrzava 
prikazivanje strana.

8. Kad podesite i izmenite parametre, pritisnite dugme OK da 
biste zatvorili okvir za dijalog Preferences i primenili nove 
parametre.

Parametri za sva  
vremena
Parametri koje izaberete ne 
odnose se samo na određeni 
dokument već na čitav program. 
Svaki put kada otvorite Acrobat 
6, program koristi parametre ko-
je ste definisali sve dok ih pono-
vo ne promenite.


